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¢ŜŎƘƴƛŎŀƭ ǊŜǉǳƛǊŜƳŜƴǘǎ 

The application eForm is an interactive PDF form that requires Adobe Reader software to be installed 
on your computer for you to be able to complete and submit it.  

The creation, download ŀƴŘ ǎǳōƳƛǎǎƛƻƴ ƻŦ ǘƘŜ ŦƻǊƳ ŀǊŜ ΨƻƴƭƛƴŜΩ ŀŎǘƛǾƛǘƛŜǎ ōǳǘ ŎƻƳǇƭŜǘƛƻƴ ƻŦ ǘƘŜ ŦƻǊƳ 
ŀƴŘ ƛǘǎ ǾŀƭƛŘŀǘƛƻƴ ŀǊŜ ΨƻŦŦƭƛƴŜΩ ŀŎǘƛǾƛǘƛŜǎΦ  

Adobe Reader 

The minimum version i.e. lowest version of Adobe Reader that you must have installed on your 
computer is version 9. You may also use a higher version than this e.g. 9.1, X, XI etc. If you have a 
lower version than 9, you will not be able to complete and submit the eForm. 

Follow the link below to be directed to Adobe's website to download the software free of charge or 
to upgrade your existing copy of the software. If you do not have administrator rights on your 
computer this activity may require the intervention of your IT department. You will need to specify 
your operating system before the download can commence. 

http://get.adobe.com/reader/otherversions/ 

If you are using Adobe Acrobat (Standard) or Adobe Acrobat Professional, the version must likewise 
be 9 or higher. 

The screenshots in this User Guide are based on version 9 of Adobe Reader. 

You can check the system requirements for Adobe Reader ς i.e. the minimum required specification 
of your computer ς through the following link: 

http://www.adobe.com/uk/products/reader/systemreqs/ 

Risk of corruption from other PDF readers 

Some non-Adobe PDF readers have been known to corrupt eForm files, rendering them unusable 
and/or unsubmittable. Only therefore use Adobe Reader or one of the Adobe Acrobat products. 

Internet Connection & Browser software 

You will require an internet connection and standard browser software to retrieve and submit the 
online application form. 

Security settings in some versions of Adobe Reader and Adobe Acrobat 

If you are using a version of Adobe Reader or Adobe Acrobat that incorporates Enhanced Security, it 
is very likely that the enhanced security settings will block the submission of your eForm. The 
involved versions of Adobe Reader and Adobe Acrobat are: 

¶ 9.3 or any higher version 9 than this (including any sub-versions e.g. 9.3.1, 9.4.2 etc); 

¶ any version X (including any sub-versions e.g. 10.0.1); 

¶ any version or sub-version higher than version X e.g. version XI. 

The disabling of the Enhanced Security is performed from the following Adobe Reader menu path: 

 Edit > Preferences > Security (Enhanced) 

http://get.adobe.com/reader/otherversions/
http://www.adobe.com/uk/products/reader/systemreqs/
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Uncheck the box Enable Enhanced Security and click OK. Once the submission has been performed 
you can re-enable the Enhanced Security. For more detailed instructions (including screenshots),  
please refer to the relevant 'Known Issue' on the EACEA eForm homepage: 

http://eacea.ec.europa.eu/eforms/index_en.php#issues 

Here you will also find instructions on how to leave Enhanced Security enabled but identify your 
eForm as a trusted item so that its submission is not blocked. 

Account with the European Commission - EU LOGIN (PREVIOUSLY KNOWN AS ECAS) 

Access to the systems involved in creating an application eForm is validated by EU LOGIN, the 
European Commission's Authentication Service. Applicants must therefore have an EU LOGIN 
account. If you do not yet have an EU LOGIN account, please visit the EU LOGIN registration website 
where you can create your account including an EU LOGIN login username and password. The 
website is reached through the following link: 

https://webgate.ec.europa.eu/cas/eim/external/register.cgi 

Test your connection 

The Test your connection button appears in the footer of every page of the eForm. Click on this 
button to verify whether your computer settings and internet connection and settings permit a 
successful connection to EACEA's submission server to be made. This is not to perform the 
submission itself but merely to test your submission capability. When successful, you will see the 
message 'The connection test succeeded' appear in the footer of your form. If it fails, you will see the 
message 'The connection test failed' appear in the footer. In the latter scenario, you should consult 
the 'Known issues' section of the eForm homepage where you will find advice on settings etc.  

When you perform the connection test, you may see a security warning message pop up: 

 

Please note! A successful connection test only remains valid if the environment and settings in which 
it was performed remain the same! If you move your form to a different computer, switch to a 
different browser or internet service provider, or change your internet, browser or PDF software 
settings you must perform the connection test again. 

Advice for Macintosh Users 

The eForm can only be opened and completed using Adobe Reader or one of the Adobe Acrobat 
products. It is not possible to open and work with the eForm using the Mac Preview viewer. 

Please therefore ensure that if your default viewer is set as Mac Preview, you nonetheless open the 
eForm with one of the Adobe products mentioned above. This advice applies to both the download 
of the form ς if you try to open it before downloading ς and to the opening of the form for its general 
ŎƻƳǇƭŜǘƛƻƴ ŀƴŘ ǎǳōƳƛǎǎƛƻƴΦ CƻǊ ƳƻǊŜ ŘŜǘŀƛƭŜŘ ŀŘǾƛŎŜΣ ǇƭŜŀǎŜ Ǿƛǎƛǘ ǘƘŜ ΨYƴƻǿƴ LǎǎǳŜǎΩ ǎŜŎǘƛƻƴ ƻŦ ǘƘŜ 
EACEA eForm homepage: 

 http://eacea.ec.europa.eu/eforms/index_en.php 

If you encounter the warning 
message, click on Allow to carry 
out the test. 

In some cases, a second security 
warning may pop up. If so, click on 
Allow to proceed with the test. 

http://eacea.ec.europa.eu/eforms/index_en.php#issues
https://webgate.ec.europa.eu/cas/eim/external/register.cgi
http://eacea.ec.europa.eu/eforms/index_en.php
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hǾŜǊǾƛŜǿ ƻŦ ǘƘŜ ǇǊƻŎŜǎǎ 

The application process requires electronic submission of proposals, via the internet.  

The steps in the application process can be seen in the schematic diagrams below. 

The first schematic diagram ς diagram A ς shows the steps that are involved when creating a brand 
new application eForm. 

The second schematic diagram ς diagram B ς shows the steps that are involved when there is a 
requirement to revise the list of participating organisations. (An 'existing' application eForm is one 
that you previously created, saved and potentially started completing but have not yet submitted.) 

A. Creation of a new application eForm 

 
B. Revise list of participating organisations and update existing application eForm 

 
 

  

1.Register  

organisations 

2.Select 
programmme, 

funding & 
language 

3.Select 
participating 
organisations 

4.Create & 
save eForm 

5.Complete 
the eForm 

6.Validation 
& submission 

1.Register  

organisations 

2.Upload 
existing 
eForm 

3.Revise list of 
participating 
organisations 

4.Create & 
save revised 

eForm 

6.Validation 
& 

submission 

5.Complete 
the revised 

eForm 
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!Φ /ǊŜŀǘƛƻƴ ƻŦ ŀ ƴŜǿ 
ŀǇǇƭƛŎŀǘƛƻƴ ŜCƻǊƳ 
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STEP 1: REGISTER ORGANISATIONS 

The first step in submitting a proposal is performed in the EAC/EACEA Participant Portal. 

Before an applicant can create an application eForm, they must ensure that all the organisations that 
will participate in the application have been registered in the EAC/EACEA Participant Portal. Each 
organisation that is registered in the Participant Portal is allocated a unique Participant Identification 
Code (PIC). The PIC is a 9 digit number that helps the European Commission and Agencies identify a 
participant. It is used in all grant-related interactions between the participants and the Commission.  

If an organisation does not have a PIC number it cannot participate in an application.  

You will need an EU LOGIN account in order to register your oganisation in the Participant Portal. If 
you do not have an EU LOGIN account, you can find a link to the EU LOGIN registration website in the 
'Technical requirements' section of this user guide. The home page of the Participant Portal also 
includes a link to the EU LOGIN registration website (click on the link 'Are you a new user?').  

To enter the Participant Portal, click on the following link: 

Enter the Participant Portal 

If your organisation has already participated in a 7th Framework Programme (Research) proposal, it is 
likely that the organisation has already received a PIC number.  You can search for existing PIC 
numbers in the Participant Portal via the 'My Organisation' option. 

The registration of your organisation in the Participant Portal will not take more than 10 minutes. 
Documents related to the organisation can also be uploaded in the portal. Please read carefully the 
call documents and information in order to know which supporting documents have to be uploaded 
in the portal. 

Please note: not only can a person register their own organisation, they may also register another 
organisation "on behalf of" that organisation. This can be helpful in case of large partnerships. 
However, because of the potential for conflicts and confusion, the "on behalf of" registration should 
be used only when strictly necessary. 

Once you have carried out Step 1, navigate to EACEA's Application eForm Homepage. 

Application eForm homepage 

The following link takes you to the Application eForm homepage on the EACEA website: 

Application eForm homepage 

Pay careful attention to the important points that are listed on the homepage. 

Once you have considered and, where necessary, addressed these points, you can proceed to the 
creation of your application eForm by clicking on the Create new application for funding button: 

    

  

http://ec.europa.eu/education/participants/portal/desktop/en/home.html
https://eacea.ec.europa.eu/PPMT/
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STEP 2: SELECT THE PROGRAMME, FUNDING OPPORTUNITY AND 
FORM LANGUAGE 

The next step is to select the programme, funding opportunity and form language version. 

A series of three numbered instructions will appear on screen. 

Instruction 1 

Select the programme you are interested in and click Search:  

  

A table of funding opportunities for your selected programme is displayed:  

 

 

If you make a mistake, simply select a different programme and click again on Search. 

You may filter the table of results using the filter-as-you-type facility. It checks all columns of the 
table for the presence of your filter text e.g.:  

 
 

 

Navigate multiple pages of results 

Filter 
results 

Set the number of 
results per page 
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Instruction 2 

Select your funding opportunity (action/strand) by clicking anywhere in its row: 

 

Your selected funding opportunity will now appear at the top of the screen and will also be 
highlighted in the results table:  

 

 

A selection menu for the form language version has also been added to the page. 

If you select the wrong funding opportunity, simply select a different funding opportunity from the 
table and it will appear at the top of the page, replacing your previous selection. 

If you wish to change to a different programme, use the Previous step button to return to the 
previous screen. 

Instruction 3 

Use the dropdown menu to select the language version of the application form you require: 

 

Please be aware that for some funding opportunities the eForm may only be available in a limited 
number of languages. 
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Once you have chosen your language version, a Next step button automatically appears: 

 

The Next step button will not appear until you have selected your funding opportunity AND selected 
the language version! 

Click on the Next step button to move to the next page and proceed with step three, selecting the list 
of participating organisations.  
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STEP 3: SELECT THE PARTICIPATING ORGANISATIONS 

In Step 1, you obtained the PIC numbers of the organisations participating in your application. You 
must now use those PIC numbers to build the list of participating organisations. The Applicant 
Organisation is also selected during this step. 

Adding organisations 

For each organisation participating in your application, enter in turn their PIC number and click on 
the Add to list button:  

 

As you add your organisations, they are listed in an on-screen table: 

 

Select the Applicant Organisation 

Directions for applications with ONLY ONE PARTICIPATING ORGANISATION 

If there is only one organisation participating in your application, click on the Next step button to 
proceed to the next page where you can confirm your various selections. In this scenario, the 
organisation you added will automatically be defined as the Applicant Organisation. 

Directions for applications with TWO OR MORE PARTICIPATING ORGANISATIONS 

When you add a second organisation, a new selection menu automatically appears above the partner 
list table. This is the menu for choosing the Applicant Organisation: 

 

This new menu should be used to specify which organisation in the list will perform the role of 
Applicant Organisation. If the Applicant Organisation already appears in your list you may select it 
now using the menu. Or you may continue adding all your organisations and then use the menu to 
select the Applicant Organisation from the full list.  

Enter a PIC number 
and click Add to list 
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The organisation that you select to be the Applicant Organisation is highlighted in pink: 

 

Whichever organisation you select as the Applicant Organisation, it will appear first in the eForm that 
you will eventually create. The Applicant Organisation is always the first one in the eForm. 

Important! 
Once you have created your application form, it is not possible to switch the role of 

Applicant Organisation to a different organisation. 

If, after creating your form, the responsibility for performing the role of Applicant Organisation 
passes to another organisation you will have to abandon the application form you had created and 
create a brand new application form.  

Coordinator selection 

Selection of the Coordinating organisation, where relevant, is wholly managed within the application 
form itself. There is no requirement during the creation of the list of participating organisations to 
specify which organisation will perform the role of Coordinator / Coordinating organisation. 

Removing organisations 

To remove an organisation from the list, check the corresponding checkbox at the end of the 
organisation row concernedΧ 

               

Χŀnd then click on the Remove checked organisation(s) button. 

Check multiple rows for multiple organisation deletion.  

To remove all rows in one go, check the checkbox on top of the columnΧ 

             

ΧŀƴŘ ǘƘŜƴ ŎƭƛŎƪ ƻƴ ǘƘŜ Remove checked organisation(s) button. 
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Organisation list complete 

When you selected the Applicant Organisation, the Next step button was added to the bottom of the 
page. When you have finished building your organisation list, click on the Next Step button to 
proceed to the next page where you will have the opportunity to confirm your selections and create 
your application form: 
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STEP 4: CREATE AND SAVE THE APPLICATION EFORM 

This page summarises the selections that you made in the previous steps:  

 

 

If all the details are complete and correct, click on the Create application eForm button. If any details 
are incorrect or missing click on the Previous step button to make the necessary changes. 

When you click on the Create application eForm button, a popup message appears: 

      

Carefully read the message content and then click OK to continue or click Cancel to return to the 
details confirmation page. 

Save the application eForm 

When faced with the option to open or save the form, SAVE it to your local computer or network 
drive. It is recommended that you use the Save As option, so that you can precisely select the 
location where the file is saved.  

It is not possible to open and fill in the application form within the browser. You must first save the 
form to your local computer or network drive. Once it has been saved, you can begin filling it in 
(using Adobe Reader or one of the Adobe Acrobat products). 

If you do not save your application form, you risk losing all the information you entered so far (PICs 
etc.) and having to start again.  
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List of partner organisations is not valid 

If, when you open your eform, the list of partner organisations is displayed and is accompanied by 
the message that your list of partner organisations is not valid, you must carefully review the items 
ǘƘŀǘ ŀǊŜ ƛƴŘƛŎŀǘŜŘ ŀǎ ōŜƛƴƎ Ψbƻǘ ǾŀƭƛŘΩΦ ¢ƘŜ ŦƻƭƭƻǿƛƴƎ ǎŎǊŜŜƴǎƘƻǘ ǇǊƻǾƛŘŜǎ ǎƻƳŜ examples of partner 
list items that are not valid:  

 

If you encounter this message, depending on the error(s), it may or may not be possible for you to 
use the eForm you just created. Please consult the following table for details of how to proceed. 

Rule not respected / Not valid item Action to take 

ά¢ƘŜ ǊƻƭŜ ƻŦ ŜŀŎƘ ǇŀǊǘƛŎƛǇŀǘƛƴƎ 
ƻǊƎŀƴƛǎŀǘƛƻƴ ǎƘƻǳƭŘ ōŜ ƛƴǘǊƻŘǳŎŜŘΦέ 

ό¢Ƙƛǎ ǇŜǊǘŀƛƴǎ ǘƻ ǘƘŜ ŦƛŜƭŘ ΨwƻƭŜ ƛƴ ǘƘŜ 
ŀǇǇƭƛŎŀǘƛƻƴΩύ 

Fill in the missing role for each organisation concerned.  

If the filling in of the roles triggers further, different validation errors, 
please consult the next row in this table for advice.   

If the filling in of the roles does not trigger further validation errors 
AND if this had been the only validation error originally displayed, you 
may continue with the completion and submission of your eForm.  

Any other item or items listed as 
being not valid. 

You will not be able to continue using the eForm in its current state as 
it is not possible to validate or submit it. Proceed as follows: 

(i) Check the eligibility rules that are in force for the funding 
opportunity you are applying under. Are you compliant with the rules? 

(ii) If one or more errors relate to organisation data that has been 
recorded in the EAC/EACEA Participant Portal, return to the Portal to 
make corrections to your organisation data (see also the next section 
ƻŦ ǘƘƛǎ ƎǳƛŘŜ Ψ¸ƻǳǊ ǎŀǾŜŘ ŦƻǊƳ - ǇǊƻǘŜŎǘŜŘ ŦƛŜƭŘǎΩύ Φ 

(iii) Once you have addressed points (i) and (ii), you may resume the 
creation of your eForm. You have two options: 

¶ Continue with the eForm you created but update it so that it 
no longer contains any items that are not valid. To do this you 
must use the button Revise list of participating organisations 
and update existing application for funding. See section B of 
this User Guide for details of how to do this. 

¶ Abandon the eForm you created and start the creation 
process again using the Create new application eForm button. 
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Your saved form - protected fields 

The funding opportunity details that you selected will appear in the form as protected i.e. 
unmodifiable fields. This is indicated by grey diagonal lines that provide the background to the fields: 

 

Likewise, the organisation information you incorporated will appear as protected fields. For example: 

 

If the organisation information that appears in the protected fields is incorrect or is out-of-date, the 
data cannot be modified directly in the eForm but must be modified in the Participant Portal. After 
the modifications have been carried out in the Participant Portal, they must also be incorporated into 
your eForm (if it has not already been submitted). In order to incorporate the modifications into your 
eForm, please follow the steps described in part B of this guide, 'Revise list of participating 
organisations and update existing application eForm'. Be aware that there can be a delay of several 
days before modifications made in the Participant Portal are validated by the Commission and 
become available for incorporation into your eForm! See part B for more details.  

Type of organisation 

LŦ ǘƘŜ ŜCƻǊƳ ȅƻǳ ŀǊŜ ǳǎƛƴƎ ƛƴŎƭǳŘŜǎ ŀ Ψ¢ȅǇŜ ƻŦ ƻǊƎŀƴƛǎŀǘƛƻƴΩ ŦƛŜƭŘΣ ǇƭŜŀǎŜ ǘŀƪŜ ƛƴǘƻ ŀŎŎƻǳƴǘ ǘƘŜ 
following advice. 

!ƭǘƘƻǳƎƘ ǘƘŜ Ψ¢ȅǇŜ ƻŦ ƻǊƎŀƴƛǎŀǘƛƻƴΩ ŦƛŜƭŘ ƛǎ ŀ ŦƛŜƭŘ ǘƘŀǘ ȅƻǳ ƘŀǾŜ ŀƭǊŜŀŘȅ ŦƛƭƭŜŘ ƛƴ ŦƻǊ ȅƻǳǊ ƻǊƎŀƴƛǎŀǘƛƻƴ 
when you registered it in the Participant Portal, it is presented in the eForm as an unprotected field 
that must be selected within the eForm. This is because the list of organisation types available in the 
eForm is tailored to the funding opportunity you are applying under. Please therefore complete the 
type of organisation field as you would any other mandatory eForm field and do not try to set its 
value via the Participant Portal. 
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STEP 5: COMPLETE THE APPLICATION EFORM 

Generic guidance  

This section provides generic guidance on how to work with and complete an application eForm. 

Navigation panel 

 

 

 
Toolbar 

From the Tools menu you can customise your toolbar e.g. you can add the Save button if it is not 
already displayed. There are also various display and navigation options that you can add. 

 

 

Toolbar 

Customise 
toolbar 

selection 
menu 

(partial 
view) 

Attach facility 

DO NOT USE! 

The eForm has its 
own attach facility 

Activate 
Page Thumbnails 

(see below) Activate the 
Highlight Fields 

facility 

VERY USEFUL! 
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Here are some of the commonly used display and navigation options: 

 

 

 

 

 

Page Thumbnails 

If you activate the Page Thumbnails option, a new panel is opened up on the left-hand side of the 
ǎŎǊŜŜƴΦ Lǘ Ŏƻƴǘŀƛƴǎ ƳƛƴƛŀǘǳǊŜ ǇǊŜǾƛŜǿǎ όΨǘƘǳƳōƴŀƛƭǎΩύ ƻŦ ŜŀŎƘ ǇŀƎŜΥ 

    

Zoom in / Zoom out 

To rapidly zoom in or out, press CTRL on your keyboard and move the scroll wheel on your mouse: 

  Scroll up  to zoom out, increasing the size of the image 
  Scroll down   to zoom in, decreasing the size of the image 

  

Zoom In 
(reduce 

image size)  

Zoom Out 
(enlarge 

image size)  

Fit form to 
width of window 
and scroll across 
page boundaries 

Show one 
 whole page 
 at a time  

Move to 
previous 

page  

Move to 
 next page  

¶ Use the 
thumbnails to 
jump to different 
pages of the form.  

 

¶ A frame outlined 
in red indicates 
where you are in 
the document. 

 

¶ Right click on the 
panel to access 
options to enlarge 
or reduce the 
thumbnails.  

Red frame 
indicating 

your 
location   
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Entering content 

The eForm is an interactive PDF form that contains form fields that are either selected from a 
restricted list or filled in using free text: 

¶ click inside a text field to enter data; 

¶ click to select options from e.g. dropdown lists, checkboxes, pop-up calendars and 
radio buttons; 

¶ press Tab to move forward one field or Shift+Tab to move backward one field; 

¶ point and click with the mouse to select a specific field. 

Mandatory, optional and protected fields 

Field Type Characteristics Examples 

Mandatory 
Field label is accompanied by an 

asterisk *   

        

Optional Field label has no asterisk 

             

Protected 

(unmodifiable) 

Field contains diagonal grey lines. 

These fields are either incorporated 
into the eForm when it is created or 
they are calculated / filled 
automatically by the form itself. 

   

 

Tooltip for long descriptions 

Where a description overflows the menu box, hover your cursor over the menu item to display the 
full description in a tooltip: 
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How to highlight mandatory fields 

Click on the purple button  in the navigation panel and this will activate the Document 
message bar which incorporates the Highlight Fields feature. 

 

Mandatory fields ς red border and a light blue background 

Optional fields ς light blue background (and a black border when you hover the cursor over them). 

        

 

 

 

Please note: if any mandatory field remains incomplete the eForm will not validate successfully and it 
will not be possible to submit your form. Where a numerical field is mandatory but you have no value 
to enter, please make sure you enter a zero to indicate your null value. 

Once you have activated the highlighting you can click the purple button  again to remove the 
Document message bar (and maximise the display of your form). 

Saving your form 

To save your form, click on the Save button on the toolbar or select Save from the File menu or press 
CTRL and S. 

 

Please ensure that you save your form on a regular basis. If you encounter a problem in your local 
computing environment and your form or your computer crashes, the Adobe Reader auto-recovery 
function will only restore your form to the point of the most recent save. 

  

Unhighlighted 
fields 

Highlighted 
fields 

Click on the Highlight Fields button and all 
mandatory and optional fields will gain 
highlighting that makes them easier to identify 
(and easier to differentiate from one another). 
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Using the Add and Delete buttons (eForm tables) 

Some fields or groups / blocks of fields are required to be completed more than once allowing you to 
build up a 'table' of information e.g. a list of political objectives or priorities. Whenever you need to 
insert a new 'blank' field or add rows to a table, you will do this by using the Add buttons. 

These buttons are coloured green. Click on them to add the desired new field or table row. 

 

 

 

 

Once you have added a field or row, the delete facility ς an orange-coloured button containing an 'x' 
ς appears so that you can delete the field, block of fields or table row concerned (and its contents!). 

Please note: some tables are optional but contain fields that are mandatory once a row has been 
added. 

Formatting 

If you enter formatted content into the form e.g. through copy-and-paste from other document 
sources, the eForm will strip off the formatting and plain text only will be pasted into the form. 

Please do not copy bullet points into your form. The formatting of some bullet points can trigger the 
requirement to download add-ons to your Adobe Reader software (so that it can handle those bullet 
points). 

Character limits 

The free text fields in the eForm have character limits that restrict the amount of text you can enter. 
These limits include both characters AND spaces. If you try to enter more characters than the limit 
allows the form will simply restrict the text to the predefined limit. Many word processing packages 
have a 'count' tool that may help you respect the limits. See also Annex 1 of this user guide for details 
of the character limits for fields where the limits are not cited directly on the eForm. 

SPECIFIC eForm advice and instructions linked to your selected funding opportunity 

The advice throughout this user guide is generic in nature i.e. it applies to all application eForms 
regardless of the programme concerned and regardless of the funding opportunity concerned.  

However, as eForms have different designs and can contain different functionality, some eForms 
require additional SPECIFIC guidance and instructions that are only relevant to their design and 
content. If your eForm requires any such specific instructions, these will be included in Annex 1 of 
this user guide. Please therefore ensure that you consult Annex 1 and take into account any guidance 
or instructions that you find there. 

Click here to 
add a new 

row Click here to 
delete a row 






































